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Warranty 

All products manufactured by ICP DAS are under warranty regarding defective materials for 

a period of one year, beginning from the date of delivery to the original purchaser. 

 

Warning 

ICP DAS assumes no liability for any damage resulting from the use of this product. ICP DAS 

reserves the right to change this manual at any time without notice. The information 

furnished by ICP DAS is believed to be accurate and reliable. However, no responsibility is 

assumed by ICP DAS for its use, not for any infringements of patents or other rights of third 

parties resulting from its use. 

 

Copyright 

Copyright @ 2018 by ICP DAS Co., Ltd. All rights are reserved. 

 

Trademark 

The names used for identification only may be registered trademarks of their respective 

companies. 

 

 

Contact US 

If you have any problem, please feel free to contact us. 

You can count on us for quick response. 

 

   Email: service@icpdas.com 
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1. Introduction 

 

 

 

 

XP-8000-CE6 Series is the new generation Windows CE 6.0 based PACs of ICP DAS. It is equipped 

with a x86 CPU (1 GHz) dual-core, various connectivity (VGA, USB, Ethernet, RS-232/485) and 

0/1/3/7 I/O slot(s) for high performance parallel I/O modules (high profile I-8K Series) and serial 

I/O modules (high profile I-87K series). The benefits of running Windows CE 6.0 on XPAC include 

hard real-time capability, small core size, fast boot speed, interrupt handling at a deeper level and 

achievable deterministic control. XPAC is also capable of running PC-based control software such as 

Visual Basic .NET, Visual C#,…. etc. It has all of the best features of both traditional PLCs and 

Windows capable PCs. 

For software copy protection, programmers can design software based on the 64-bit hardware 

serial number for making software copy protected. 
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1.1. Features 

The XP-8000-CE6 offers the most comprehensive configuration to meet specific application 

requirements. The following list shows the hardware and software features designed to simplify 

installation, configuration and application. 

 

Hardware Features 

 Powerful CPU module: x86 CPU (1 GHz) dual core 

 Rich Memories: 

System Memory: 2 GB DDR3 

Built-in Flash Disk: 32 GB 

EEPROM: 16 KB 

SRAM/MRAM: 512 KB 

 VGA Port x 1, USB 2.0 port x 4, Serial port (RS-232/RS-485) x 5 

 64-bit Hardware Serial Number 

 Dual Watchdog Timers 

 Dual Ethernet Ports (10 M/100 M/1000 M) 

 Redundant Power Input 

 Operating Temperature: -25 to +75 °C 

 

 

Software Features 

 Windows Compact Edition 6.0 

 ASP 

 SQL Compact Edition 3.5 

 .NET Compact Framework 3.5 

 Remote Display 

 Built-in OPC Server (Quicker) 

 Rich Software Solution – SDK for Microsoft Visual Studio 2005/2008 
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1.2. Specifications 

The table below summarizes the specifications of the XP-8000-CE6. 

 

Models XP-8031-CE6 XP-8131-CE6 XP-8331-CE6 XP-8731-CE6 

 

OS Windows CE 6.0 

.Net Compact Framework 3.5 

Embedded Service FTP Server, ASP (Java Script, VB Script), SQL Compact Edition 3.5 

SDK Provided Dll for Visual Studio .Net 2005/2008 

Multilanguage Support 
English, German, French, Spanish, Russian, Italian, Czech, Japanese, 

Korean, Simplified Chinese, Traditional Chinese 

CPU Module 

CPU x86 CPU, 1 GHz, dual-core 

SDRAM 2 GB DDR3 

MRAM , Non-volatile Memory 512 KB (Retain memory without battery support) 

Flash 32 GB 

EEPROM 16 KB 

CF Card CF slot with one CF card (support up to 32 GB) 

RTC (Real Time Clock) Provide second, minute, hour, date, day of week, month, year 

64-bit Hardware Serial Number Yes, for software copy protection 

Dual Watchdog Timers Yes (0.8 second) 

Rotary Switch Yes (0 to 9) 

DIP Switch - Yes (8 bits) 

Programmable LED Indicator 2 (L1 and L2) 

VGA & Communication Ports 

VGA Resolution 1400x1050, 1024 x 768, 800 x 600 , 640 x 480 

Dual Ethernet Port 
RJ-45 x 2, 10/100/1000 Base-T (Auto-negotiating, Auto MDI/MDI-X, 

LED indicators) 

USB 2.0 4 

COM 1 

RS-232 (RxD, TxD 

and GND); 3000 

VDC isolated 

Internal communication with high profile I-87K 

series modules in slots 
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COM 2 RS-232 (RxD, TxD and GND); 3000 VDC isolated 

COM 3 RS-485 (Data+, Data-); 3000 VDC isolated 

COM 4 
RS-232/RS-485 (RxD, TxD, CTS, RTS and GND for RS-232, Data+ and 

Data- for RS-485); 3000 VDC isolated 

COM 5 RS-232 (RxD, TxD, CTS, RTS, DSR, DTR, CD, RI and GND); non-isolated 

I/O Expansion Slots 

Number of I/O slots 0 1 3 7 

Supported I/O modules I-8K and I-87K series I/O Modules 

Mechanical 

Dimensions (W x L x H),  

unit: mm 
137 x 132 x 125 169 x 132 x 125 231 x 132 x 125 355 x 132 x 125 

Installation DIN-Rail or Wall Mounting 

Environmental 

Operating Temperature -25 °C to +75 °C 

Storage Temperature -30 °C to + 80 °C 

Ambient Relative Humidity 10 % to 90 % RH (non-condensing) 

Power 

Input Range +10 VDC to +30 VDC 

Redundant Power Inputs Yes, with one power relay (1 A @ 24 VDC) for alarm 

Isolation 1 kV 

Capacity 

2.2 A, 5 V 

supply to CPU 

and backplane, 

20W in total 

3.7 A, 5 V 

supply to CPU 

and backplane, 

1.3 A, 5 V 

supply to I/O 

expansion 

slots, 25 W in 

total 

3.8 A, 5 V 

supply to CPU 

and backplane, 

3.2 A, 5 V 

supply to I/O 

expansion 

slots, 30 W in 

total 

4.0 A, 5 V 

supply to CPU 

and backplane, 

3.0 A, 5 V 

supply to I/O 

expansion 

slots, 35 W in 

total 

Consumption 
12W (0.5 A @ 

24 VDC) 

16.6 W (0.69 A 

@ 24 VDC) 

16.8 W (0.7 A 

@ 24 VDC) 

18 W (0.75 A @ 

24 VDC) 
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1.3. Overview 

The XP-8000-CE6 is equipped with several interfaces and peripherals that can be integrated with 

external systems. Here is an overview of the components and its descriptions.  

 

 

XP-8031-CE6 

 

 

 

 

XP-8131-CE6 
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XP-8331-CE6 

 

 
 

 

 

XP-8731-CE6 
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The details of these items are as follows: 

LED Indicators 

 

 

The XP-8000-CE6 has 4 LED indicators. The first is 

labeled PWR, located near the power switch and 

shows the power status. The three other are located 

next the rotary switch, the left one is labeled RUN and 

shows the operation status, the two other are 

denoted L1 and L2 and used for user defined. 

 

 

LED Indicator Label State (Color) Meaning 

Programmable LED Indicators  L1 and L2 - Programmable LED indicators 

System LED indicator RUN Orange OS is running 

Power LED Indicator PWR Green Power 1 is on 

 

 

Operating mode Selector   

 

Rotary Switch is an operating mode selector. The XP-8000-CE6 has 

several operating modes, for more detailed information about 

these operating mode, please refer to “2.2 Configuring the Boot 

Mode” 

 

 

 

 

 

 

Power Switch  

 

The power switch is a small switch that enables 

or disables power to electric circuits and loads in 

the XP-8000-CE6. 
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Redundant Power (PWR1 and PWR2) and relay output 

 

The XP-8000-CE6 has a 2-row 10-wire terminal block; there has 4-wire for redundant power inputs 

and 2-wire for relay output. The details of the redundant power are shown to the side. 

 

 
 

● Redundant Power 

The XP-8000-CE6 provides redundant power 

that can keep the device running if a problem 

occurs in the power supply.   

 

● Relay Output 

The XP-8000-CE6 has a relay output that can be 

used to control a light, siren, or other low 

voltage device when an alarm occurs.   

 

 

Communication Ports 

 

The XP-8000-CE6 is equipped with several interfaces and peripherals that can be integrated with 

external systems. 

 

 

● CF slot 

The CF slot comes with a free CF card that can be used to restore the system, and expand the 

memory up to 32 GB. 

 

Tips & Warnings 

The XP-8000-CE6 Doesn't Support Hot Swap.  

The XP-8000-CE6 does not support hot swapping of CF cards, you need to shut down the 

XP-8000-CE6 before you insert the CF card. 
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● VGA Port 

The VGA connector is a 3-row 15-pin connector that can be used to connect a 

monitor at a variety of supported VGA resolutions. and the output resolution 

covers, 800 x 600, 1024 x768 and 1400 x 1050. 

 

 

● Ethernet Ports (LAN1 and LAN2) 

The XP-8000-CE6 has 2 Ethernet ports that can be used to connect the router to the Internet or 

to other devices. 

 

Each Ethernet port has 2 LED indicators, which are used to indicate the 

network speed and Link/Acting, as described below. 

 

LED Indicator State (Color) Meaning 

1G ON (Yellow) Network Speed: 1 GB 

OFF Network Speed: 10/100 MB 

Link/Act ON (Green) The Link is active 

OFF The Link is inactive 

Blinking(Green) Network activity 

 

 

● USB Ports (P1, P2, P3 and P4) 

The XP-8000-CE6 has 4 USB 2.0 ports that can be used to connect the USB devices such as 

mouse, keyboard or an external USB hard drive.  

 

 

● COM1 (RS-232) (for XP-8031-CE6 only) 

The COM1 port is a 9-pins RS-232 connector. The details of the COM1 port specifications are 

shown to the side. 

Port Type: Male 

Baud Rate: 115200, 57600, 38400, 19200, 9600, 4800, 2400, 1200 bps 

Data Bits: 5, 6, 7, 8 

Parity: None, Even, Odd, Mark (Always 1), Space (Always 0) 

Stop Bits: 1, 2 

FIFO: 128 bytes  
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● COM2 (RS-232) 

The COM2 port is a 9-pins RS-232 connector. The details of the COM2 port specifications are 

shown to the side. 

Port Type: Female 

Baud Rate: 115200, 57600, 38400, 19200, 9600, 4800, 2400, 1200 bps 

Data Bits: 7, 8 

Parity: None, Even, Odd 

Stop Bits: 1 

FIFO: 1 byte 

 

 

● COM3 (2-wire RS-485) 

Port Type: Terminals 

 Baud Rate: 115200, 57600, 38400, 19200, 9600, 4800, 2400, 1200 bps 

Data Bits: 5, 6, 7, 8 

Parity: None, Even, Odd, Mark (Always 1), Space (Always 0) 

Stop Bits: 1, 2 

FIFO: 128 bytes  

 

 

● COM4 (RS-232/RS-485) 

The COM4 port is a 9-pins RS-232/RS-485 connector. The details of the COM4 port specifications 

are shown to the side. 

Port Type: Male 

Baud Rate: 115200, 57600, 38400, 19200, 9600, 4800, 2400, 1200 bps 

Data Bits: 5, 6, 7, 8 

Parity: None, Even, Odd, Mark (Always 1), Space (Always 0) 

COM4 can be configured as either RS-232 or RS-485, that only can select one at a time and its 

configuration depends on the pin connections as follows: 

- RS-232 (RXD, TXD, CTS, RTS and GND) 

- RS-485 (Data+ and Data-) 

There is no software configuration or hardware jumper needed. 
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● COM5 (RS-232) 

The COM5 port is a 9-pins RS-232 connector. The details of the COM5 port specifications are 

shown to the side. 

Port Type: Male 

Baud Rate: 115200, 57600, 38400, 19200, 9600, 4800, 2400, 1200 bps 

Data Bits: 5, 6, 7, 8 

Parity: None, Even, Odd, Mark (Always 1), Space (Always 0) 

Stop Bits: 1, 2 

FIFO: 16 bytes  

 

Tips & Warnings 

1. All COM ports of XP-8000-CE6 don’t support Mark and Space parity settings. 

2. The table below shows the data bit and their corresponding stop bit for COM2, COM3 

COM4, and COM5 

Word Length Number of Stop Bits 

5, 6, 7, 8 1 

5 1.5 

6, 7, 8 2 
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1.4. Dimensions 

The diagrams below provide the dimensions of the XP-8000-CE6 to use in defining your enclosure 

specifications. Remember to leave room for potential expansion if you are using other components 

in your system. 

 

The height dimension is the same for all XP-8000-CE6. The width depending on your choose of I/O 

expansion slots. All dimensions are in millimeters.  

 

XP-8031-CE6/XP-8131-CE6/XP-8331-CE6/XP-8731-CE6 

Left Side View  

 

 

 

 

 

 

 

 

 

 

 

 

 

XP-8031-CE6 

Front View  
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XP-8131-CE6 

Front View  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

XP-8331-CE6 

Front View  
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XP-8731-CE6 

Front View  
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For XP-8x31-CE6: 

   CD:\XP-8X3X-CE6\ 

Backup 

The file packages for each release. 

demo 

The demo programs for examples of use in the application. 

Document 

The technical support documents for installation, operation, maintenance, 
development and application. 

OS_image 

The related information for OS releases and technology. 

PC_Tools 

The tools and utilies for operation with PC. 

RESCUE 

The files for system instllation. 

Rescue_Disk 

The ghost files for OS  backups and restores. 

SDK 

The sources for development and application in your application. 

System_Disk 

The tools and drivers related to System_Disk that install on XP-8000-CE6. 

1.5. Companion CD 

This package comes with a CD that provides a collection of the software utility, documentation, 

drivers, demo program and application.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

. 
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2. Getting Started 

This chapter provides a guided tour of the XP-8000-CE6 installation and configuration that 

describes the steps needed to download, install, configure, and run the basic procedures for user 

working with the XP-8000-CE6 for the first time. 

 

Before starting any task, please check the package contents. If any of the following package 

contents are missing or damaged, contact your dealer, distributor. 

 

 

 

 

 

 

 

  

XP-8000-CE6  CF Slot with one CF card 

 

 

  

 

 

 

 

 

  

Quick Start Guide Software Utility CD Screw Driver (1C016) 2.4 mm 
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2.1. Mounting the Hardware 

Before you work with the XP-8000-CE6, you should have a basic understanding of hardware 

specification, such as the dimensions, the usable input-voltage range of the power supply, and the 

type of communication interfaces. 

For more information about the hardware details, please refer to “1.2. Specifications” 

For more information about the hardware dimensions, please refer to “1.4. Dimension” 

 



XP-8000-CE6 User Manual (for WinCE 6.0 Based XPAC), version 1.0.5         Page: 24 

Copyright ©  2018 ICP DAS Co., Ltd. All Rights Reserved.   E-mail: service@icpdas.com 

 

2.1.1. Mounting the XP-8000-CE6 

The XP-8000-CE6 can be mounted either directly to a wall/panel, or onto a standard 35mm DIN 

rail.  

 

 

Wall/Panel mounting 

 

 

Step 1: Install the four mounting 
screws into the 4 keyhole 
mounting holes 

Step 2: Fasten the screws securely 

 

 

 

 

 

 

Tips & Warnings 

There must be a minimum clearance of 50mm between the XP-8000-CE6 and the top and 

bottom side of the enclosure panel. 
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DIN Rail mounting 

 

Step 1: Hook upper tab over upper flange of DIN rail 

Step 2: Tilt the module toward DIN rail until it snaps securely to DIN rail  
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Tips & Warnings 

A good common ground reference (earth ground) is essential for proper operation of the 

XP-8000-CE6. One side of all control circuits, power circuits and the ground lead must be 

properly connected to earth ground by either installing a ground rod in close proximity to 

the enclosure or by connecting to the incoming power system ground. There must be a 

single-point ground (i.e. copper bus bar) for all devices in the enclosure that require an 

earth ground.  
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2.1.2. Deploying a Basic XP-8000-CE6 System 

The XP-8000-CE6 provides a variety of communication interface to suit a range of application. Here 

is a simple application for using the XP-8000-CE6. 

 

Step 1: Connect the positive terminal (+) of the power supply to the terminal PWR1/2 
and the negative terminal (-) of the power supply to the P.GND 

 

 

 

Tips & Warnings 

1. The input range of power supply is +10 to +30 VDC. 

2. The XP-8000-CE6 have two power inputs that can be connected simultaneously to the 

two independent power sources. If one power source fails, the other source takes over 

automatically. Redundant power inputs help assure non-stop operation of the 

XP-8000-CE6. 
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Step 2: Connect the USB mouse or the USB keyboard to the USB port 

Step 3: Connect the monitor to the VGA port 

Step 4: Connect to PC or the laptop to the LAN port via an Ethernet switch 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



XP-8000-CE6 User Manual (for WinCE 6.0 Based XPAC), version 1.0.5         Page: 29 

Copyright ©  2018 ICP DAS Co., Ltd. All Rights Reserved.   E-mail: service@icpdas.com 

 

2.1.3. Inserting the I/O Modules 

XP-8000-CE6 has 0/1/3/7 I/O expansion slot(s) and only supports I-8K and I-87K series I/O 

modules.  

 

Before choosing the right I/O modules, you first need to know the I/O expansion capacities in 

order to choose the best expansion module for achieving maximal efficiency. For more information 

about the I/O expansion modules that are compatible with the XP-8000-CE6, please refer to: 

http://www.icpdas.com/root/product/solutions/remote_io/rs-485/i-8k_i-87k/i-8k_i-87k_selection.

html 

 

 

 

Step 1: Align circuit card with slot and 
press firmly to seat module into 
connector 

 

 

 

 

 

 

 

 

 

 

 

Tips & Warnings 

It is recommended that the power to the XP-8000-CE6 is switched off when wring the I/O 

module which are plugging in the XP-8000-CE6 slots. 

 

 

 

 

 

 

 

http://www.icpdas.com/root/product/solutions/remote_io/rs-485/i-8k_i-87k/i-8k_i-87k_selection.html
http://www.icpdas.com/root/product/solutions/remote_io/rs-485/i-8k_i-87k/i-8k_i-87k_selection.html
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Step 2: Pull top and bottom locking tabs toward module face. Click indicates lock is 
engaged 

 

 

 

 

 

 

 

 

 

 

 

 

Step 3: Attach field wiring using the terminal block, and then insert the terminal block 

All I/O Web Page include the I/O module specifications, pin assignments and wiring connections.  

For example, Pin Assignments and Wiring connections for the I-87054W module are as follows: 

http://www.icpdas.com/root/product/solutions/remote_io/rs-485/i-8k_i-87k/i-87054w.html 

 

 

 

http://www.icpdas.com/root/product/solutions/remote_io/rs-485/i-8k_i-87k/i-87054w.html
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2.1.4. Powering up the XP-8000-CE6 

The XP-8000-CE6 works with 24 VDC power and provides redundant power inputs with two 

terminal blocks for PWR1 and PWR2 input.  

 

 

Step 1. Wire to power supply 

There are two ways to supply power to the XP-8000-CE6. 

 

 

 

Single power supply 

 

 

 

 

 

 

 

 

 

 

 

 

Tips & Warnings 

Once you wire and power up the power supply, confirm the PWR indicator 

(Red LED) on the CPU module is on. 

If the indicator is not on, check the voltage on the terminal block with a 

voltage meter. If you measure 24 VDC on the terminal block, the CPU module 

may be defective. Please contact us. 
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Redundant power supply 

The redundant power can be used single and used two self-governed power to supply to the 

system, PWR1 and PWR2 input at the same time, when one power fails, the other power acts as a 

backup, and automatically supplies power needs. 
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Step 2. Check the boot status 

When powering on the XP-8000-CE6, please note the four LED statues to make sure the boot is 

correct. The booting process takes about 40~50 seconds.  

 

 

 

i. Switch the power switch to the on position 

 

 

 

 

 

 

 

ii. Load BIOS 

 

 

 

 

iii. Enter the welcome screen 

 

 

 

 

iv. Start to load OS 

 

 

 

 

 

 

After power on, the LED will be on. 
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v. OS load successfully 

 

 

 

vi. The boot process has been finished successfully. 

 

Tips & Warnings 

 

After the boot process has been finished, the L1 and L2 LED indicators will be released. The 

user can use XPAC API to control them. 

The LED light status of XP-8x31-CE6 is different in phase 1 and the status is same in the other 

phase. 
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2.2. Configuring the Boot Mode 

The XP-8000-CE6 has several operating modes, which can be selected by a rotary switch. 

 

 

 

 

 

 

 

 

 

 

 

 

 

The table below lists the operation modes available with the XP-8000. 

Position Operating Mode 

0 Normal mode (Default) 

1 Safe mode 

2 (For user defined mode) 

3 (For user defined mode) 

4 (For user defined mode) 

5 (For user defined mode) 

6 (For user defined mode) 

7 (For user defined mode) 

8 DCON_CE 

9 Remote Display mode 

 

 

The following is a brief introduction of these modes. 

 

Normal Mode (Default mode) 

Normal mode is the default mode of operation and the one you will use most of the time. Use this 

mode for more tasks and configurations. Programs also are executed in this mode. 
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Safe Mode 

Safe mode is a troubleshooting mode. The mode loads the minimum required device drivers and 

system services to boot the XP-8000-CE6. 

If you have malicious software or a program caused the XP-8000-CE6 cannot be boot or run the normal 

mode, you can boot in safe mode to solve the problem. 

 

DCON_CE 

In this mode, the DCON_CE will be run automatically, and other settings are same as the normal mode. 

For more information about the DCON CE, please refer to section 3.3. DCON CE. 

 

Remote Display 

In this mode, the cerdisp.exe will be run automatically, and other settings are same as the normal 

mode. 

For more information about the Remote Display, please refer to section 2.5. Using Remote Display to 

Control the XP-8000-CE6 Remotely. 

 

 

User Mode 

The positions 2~7 of rotary switch are reserved for user’s applications. 

When XP-8000-CE6 is boot with one of these positions, it is boot at normal mode. User’s application 

can check the position of the rotary switch position to run at different mode. 
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2.3. Changing the User Interface Language  

The Regional and Language Settings is a Windows CE functionality that allows users to change the 

XP-8000-CE6 user interface with your native language. 

 

 

 

Step 1: Click Start menu, point to Settings, click Control Panel, and then click Regional 
Settings 
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Step 2: Click User Interface Language tab, choose to your local language, and then click 
OK button 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 3: Double-click the XPAC Utility on the desktop, and then reboot the XP-8000-CE6 
for changes to take effect 
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2.4. Using XPAC Utility to Manage the XP-8000 

The XPAC Utility is a collection of the XP-8000-CE6 system tool that allows users to manage and 

configure the XP-8000-CE6 quickly and easily. 

 

For more detailed information on XPAC Utility applications, please refer to “3.1. XPAC Utility” 

 

Step 1: Double-click the XPAC Utility on the desktop 

Step 2: Configure IP address (DHCP), FTP Server, Auto Execution files…, etc. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Step 3: Reboot the XP-8000-CE6 for changes to take effect 
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2.5. Using Remote Display to Control the XP-8000-CE6 Remotely 

The "Remote Display" is a Windows CE functionality that allows XP-8000-CE6 to be controlled and 

monitored from a remote location. This tool is composed of two parts, a client and a server. The 

server is a program named cerdisp.exe running on XP-8000-CE6. The client is a PC-based program 

named cerhost.exe running on the PC. 

Here are step by step instructions on how to use Remote Display to control XP-8000-CE6 remotely. 

 

Step 1. On PC side, click client program, cerhost.exe 

The Remote Display can be installed from the CD or by downloading the latest 

version from ICP DAS web site. 

CD:\XP-8000-CE6\PC_Tools\Remote_Display\ 

ftp://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/pc_tools/remote_display/ 

 

 

 

 

 

 

Step 2. On XPAC side, click server program, cerdisp.exe 

The cerdisp.exe are pre-installed on the 

XP-8000-CE6, located under 

\System_Disk\Tools\Remote_Display 
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Step 3. Click OK button, click Connect button, type the IP address of the host PC 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 4. The remote connection has been established 
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2.6. Using DCON Utility Pro Configure I/O Modules 

DCON Utility Pro allows users to configure and manage the I/O modules via Ethernet or serial ports 

(RS-232/RS-485). 

 

Step 1: Double-click the DCON_Utility_Pro on the desktop 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 2: Click the         button 
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Step 3: Configure the communication settings 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tips & Warnings 

The COM port settings for expansion I/O modules are listed below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

COM 2/3/4/5 

For more information on these COM port selections, please refer to the 

specification of the pin assignments in section 1.3. Overview 

COM1 [Backplane] 
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Step 4: Click the         button to scan the I/O module 

Step 5: Click the module name to configure the I/O module 
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2.7. Using DCON_CE to Remote Configure the I/O Module 

The DCON Utility is a client utility that runs on PC, and communicates with XP-8000-CE6 via DCON 

protocol. The DCON Utility allows users to remotely connect to I-7K and I-87K series I/O modules 

for management through the COM port and Ethernet port. 

This tool is composed of two parts, a client and a server. The server is a program named 

DCON_CE_XP running on XP-8000-CE6. The client is a PC-based program named DCON Utility 

running on the PC. 

 

Here are step by step instructions on how to use DCON Utility to configure the I/O modules. 

 

 

Step 1. On XPAC side, click server program, DCON_CE 

The DCON_CE_XP are pre-installed on the XP-8000-CE6, located under 

\System_Disk\Tools\DCON_CE 
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Step 2. On PC side, Run the DCON Utility  

The DCON Utility can be installed from the CD that was provided with the package or 

by downloading the latest version from ICP DAS web site. 

CD:\XP-8000-CE6\PC_Tools\DCON_Utility\ 

ftp://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/pc_tools/dcon_utility/ 

 

 

 

 

 

 

 

 

 

 

 

Step 3. Click WINCE common button  

 

 

 

 

 

 

 

 

 

 

 

 

 

ftp://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/pc_tools/dcon_utility/


XP-8000-CE6 User Manual (for WinCE 6.0 Based XPAC), version 1.0.5         Page: 47 

Copyright ©  2018 ICP DAS Co., Ltd. All Rights Reserved.   E-mail: service@icpdas.com 

 

Step 4. Click XPAC_CE tab, type the IP address of the XPAC, and then click Connect to 

XPAC_CE button 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tips & Warnings 

If DCON Utility cannot connect to XP-8000-CE6, the Ethernet connection between 

Host PC and XP-8000-CE6 might be rejected by fire wall, please contact with MIS 

to open the Ethernet port. 
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Step 5. Click on the module name from the list to configure the settings form 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tips & Warnings 

If there is no operation within 30 seconds, the connection will automatically close 

to release the COM port occupied. 
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3. Tools and Tasks 

This chapter provides a brief introduction of the XP-8000-CE6 service tools and its benefits. 

 

There are several tools and utilities built-in and designed for use with XP-80006. Some of these are 

pre-installed on XP-8000-CE6 and can work directly on XP-8000, and some of these are supporting 

tools and can help you to manage the XP-8000-CE6 remotely on a PC. 

 

The following tools are pre-installed on XP-8000-CE6 and can work directly on XP-8000-CE6 that 

can be found on the CD that was provided with the package or by downloading the latest version 

from ICP DAS web site. 

 

▪ For XP-8x31-CE6: 

   CD:\XP-8X3X-CE6\System_Disk\Tools\ 

   http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/system_disk/tools/ 

Dcomcnfg 

DCON_CE 

DCON_Utility_Pro 

ISQLW35 

modbus_master_tool 

NAPOPC_CE6 

Notepad 

RegEdit 

Remote_Display 

SendToCOM 

TaskMgr 

VCEP 

XPAC_Utility 
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3.1. XPAC Utility 

XPAC Utility is a collection of software applications that enable management and configuration of 

XP-8000-CE6 system and features.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The XPAC Utility includes the following menu bars and property tabs.  

All of these functions will be explained later. 

 

Menu bar Property Tab 

File 

Help 

General 

General2 

Display 

IP Config 

Network 

Device Information 

Auto Execution 

Rotary Execution 

Multi-IO Module 

Backplane Compatibility 
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3.1.1. Menu Bar – File 

 

 

By default, the available default items are shown to 

the right. 

 

 

 

All menu items will be enabled when the Manual Save To Flash option is selected. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The menus use to How to use 

Save 
By default, this item is disabled until the Manual Save To Flash 

option is selected. Saves the changes. 

Save and Reboot 

By default, this item is disabled until the Manual Save To Flash 

option is selected. Saves the changes and reboots the 

XP-8000-CE6. 

Reboot Restarts the XP-8000-CE6. 

Restore Utility Default Settings Restore the XP-8000-CE6 to default settings. 

Exit Exits the XPAC Utility. 
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3.1.2. Menu Bar – Help 

  

 

 

 

 

 

 

 

 

 

 

 

 

The menus use to How to use 

About Displays a dialog box with information about XPAC Utility, 

including the current version and copyright information. 
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3.1.3. Property Tab - General 

The General tab provides functions to configure the task bar, check the status of the battery…, etc. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Lock or Auto-Hide 

the taskbar 

Auto-Hide the taskbar:  

Select the Auto Hide check box. 

Lock the taskbar:  

Select the Always On Top check box. 

Auto save or 

manual save to 

flash 

Auto save to flash: 

Select the Auto Save To Flash (Default) check box. 

Any changes made to the XP-8000-CE6 will be saved and only take effect 

after the XP-8000-CE6 reboots.  

Manual save to flash:  

Select the Manual Save to Flash 

check box.  

Any changes made to the 

XP-8000-CE6 will be saved by 

clicking the Save and Reboot from 

File menu. 
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The tab use to How to use 

Enable USB autorun Select the Enable Autorun in plugging USB Disk check box. 

Monitor the information of 

battery 1 and battery 2 

See the Battery1 and Battery2 field that displays the battery 

status. 

Automatic synchronization 

of system time 

Refer to the Appendix A.2. How to configure the service for 

automatically synchronizing with the internet time server. 
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3.1.4. Property Tab – General2 

The General2 tab provides functions to specify the name of the USB disk. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Specify the name of the USB disk 
Enter a name in the USB Hard Disk: field, and then click 

the Set button. 
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3.1.5. Property Tab – Display 

The Display tab provides functions to configure the monitor settings. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Adjust the screen 

resolution 

Move the slider to the left to decrease the resolution or move the 

slider to the right to increase the resolution, and then click the Apply 

button. 

Change the screen 

refresh rate 

Select the desired refresh rate from the Screen refresh rate 

drop-down list, and then click the Apply button. 

Display depth Select the “16 bit” or “32 bit” to setting the display depth, and then 

click the Apply button. 

The display depth default setting is “16 bit”. 
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3.1.6. Property Tab – IP Config 

The IP Config tab provides functions to configure either DHCP (Roaming) or manually configured 

(Static) network settings and to monitor the MAC address. Generally, DHCP is the default settings, 

but if you don’t have a DHCP server, you must configure the network settings by using manual 

configuration. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Set the network 

settings 

Use DHCP to get IP address: 

Select the Use DHCP to get IP address option, and then click the Apply 

button. 

Assign an IP address: 

Select the Assign IP address option, and then click the Apply button. 
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3.1.7. Property Tab – Network 

The Network tab comprises three tabs – Access, Login and File Server Settings. 

 

 

Access 

The Access tab provides functions to enable/disable the FTP access, enable/disable anonymous 

FTP access, and configure the FTP and HTTP directory path. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Enable or disable the 

FTP access 

Enable the FTP access: 

Select the Enable check box in the FTP field, and then click the 

Apply button. 

Disable the FTP access: 

Select the Disable check box in the FTP field, and then click the 

Apply button. 
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The tab use to How to use 

Enable or disable 

anonymous FTP 

access 

Enable anonymous FTP access: 

Select the Enable check box in the Allow Anonymous field, and then 

click the Apply button. 

Disable anonymous FTP access: 

Select the Disable check box in the Allow Anonymous field, and then 

click the Apply button. 

Set the FTP 

directory path 

Enter a new path in the Set FTP default download directory to: field, 

and then click the Apply button. 

Set the HTTP 

directory path 

Enter a new path in the Set HTTP document root directory to: field, 

and then click the Apply button. 

 

 

Login 

The Login tab provides functions to maintain the FTP accounts. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Maintain the FTP 

accounts 

Refer to the Appendix D.1 How to add a user account to remote 

login the XP-8000-CE6 from PC. 
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File Server Settings 

The File Server Settings tab provides functions to set the SMB server. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Set the SMB server Click the Settings button to set the SMB server path. 
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3.1.8. Property Tab – Device Information 

The Device Information tab provides functions to monitor necessary system information of the 

XP-8000. The information is the most important note of version control for upgrading system. 
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3.1.9. Property Tab – Auto Execution 

The Auto Execution tab provides functions to configure programs running at XP-8000-CE6 startup, 

it allows users to configure ten execute files at most. 

 

Tips & Warnings 

The specific extensions are .exe and .bat, and they are executed in order of program 1, 

program 2, etc. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Configure programs 

running at startup 

Click the Browse button to select the execute file which you want, 

and then click the Apply button. 
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3.1.10. Property Tab – Rotary Execution 

The Rotary Execution tab provides function to decide which mode XP-8000-CE6 executes at 

startup. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Start XP-8000-CE6 in normal mode 
Turn the rotary switch in position 0 and reboot the 

XP-8000-CE6. By default, this item is disabled. 

Start XP-8000-CE6 in safe mode 
Turn the rotary switch in position 1 and reboot the 

XP-8000-CE6. By default, this item is disabled. 

Start XP-8000-CE6 in normal mode and 

auto execute the user-specified program 

Click the Browse button to select the execute file 

which you want, click the Apply button, and then 

turn the rotary switch in position 2/3/4/5/6/7 and 

reboot the XP-8000-CE6.  

Start XP-8000-CE6 in normal mode and 

auto execute the DCON CE utility 

Turn the rotary switch in position 8 and reboot the 

XP-8000-CE6. By default, this item is disabled. 

Start XP-8000-CE6 in normal mode and 

auto execute the Remote Display server 

Turn the rotary switch in position 9 and reboot the 

XP-8000-CE6. By default, this item is disabled. 

 

 



XP-8000-CE6 User Manual (for WinCE 6.0 Based XPAC), version 1.0.5         Page: 64 

Copyright ©  2018 ICP DAS Co., Ltd. All Rights Reserved.   E-mail: service@icpdas.com 

 

3.1.11. Property Tab – Multi-IO Modules 

The Multi-serial port provides functions for installation of the RS-232/RS-422/RS-485 

communication module driver. 

The table below shows the expansion RS-232/RS-422/RS-485 communication modules that are 

compatible with the XP-8000-CE6. 

 

Item RS-232 RS-422/RS-485 Isolation Connector 

I-8112iW 2 - 2500 Vrms DB-9 x 2 

I-8114W 4 - - DB-37 x 1 

I-8114iW 4 - 2500 Vrms DB-37 x 1 

I-8142iW - 2 2500 Vrms Terminator block x 1 

I-8144iW - 4 2500 Vrms Terminator block x 1 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Set the port name 

Select the name type and order type from the 

Selection COM Port Type and Select order type 

options, and then click the Set button. 
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3.2. DCON Utility Pro 

DCON Utility Pro enables users easily to configure and manage the I/O modules via Ethernet or 

serial ports (RS-232/RS-485).  

 

For more information on how to use DCON Utility Pro to configure I/O modules, please refer to 2.6. 

Using DCON Utility Pro to Configure I/O Modules 

 

For more detailed information on DCON Utility application, please refer to: 

http://www.icpdas.com/root/product/solutions/software/utilities/dcon_utiltiy_pro.html 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.icpdas.com/root/product/solutions/software/utilities/dcon_utiltiy_pro.html
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3.3. DCON_CE 

The DCON_CE is a server program based that runs on XP-8000-CE6, and communicates with PC via 

DCON protocol.  

The DCON Utility is a client utility that runs on PC, and communicates with XP-8000-CE6 via DCON 

protocol. The DCON Utility allows users to remotely connect to I-7K and I-87K series I/O modules 

for management through the COM port and Ethernet port. 

This tool is composed of two parts, a client and a server. The server is a program named 

DCON_CE_XP running on XP-8000-CE6. The client is a PC-based program named DCON Utility 

running on the PC. 
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3.4. TaskMgr 

The TaskMgr is a Windows CE application, which provides real time info on all processes and 

threads including System threads, similar in appearance to the Windows Task Manager.  
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3.5. VCEP 

ICP DAS VCEP is designed for managing your XP-8000-CE6 anywhere. No matter where you are, ICP 

DAS VCEP provides a convenient environment on the Desktop PC and lets you control your 

XP-8000-CE6 remotely. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ICP DAS VCEP is composed of two main components: The Server which runs on XP-8000-CE6 and 

the Client which runs on a Desktop PC.  

 

Once a connection is established between the client and server (initiated by the client), the client 

will periodically send requests for screen updates and send mouse/key click information to the 

server to simulate.  

 

Each video frame is inter-compressed against the previous frame and then intra-compressed with a 

modified LZW scheme to minimize the amount of data transmitted from server to client. 

 

For more detailed information on VCEP application, please refer to 

http://www.icpdas.com/root/product/solutions/software/utilities/vecp/vecp.html 

 

http://www.icpdas.com/root/product/solutions/software/utilities/vecp/vecp.html
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3.6. Remote_Display 

The Remote Display allows XP-8000-CE6 to be controlled and monitored from a remote location.  

 

This tool is composed of two parts, a client and a server. The server is a program named 

cerdisp.exe running on XP-8000-CE6. The client is a PC-based program named cerhost.exe running 

on the PC. 

 

Once a connection is established between the client and server (initiated by the client), the client 

will periodically send requests for screen updates and send mouse/key click information to the 

server to simulate.  
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3.7. SendToCOM 

The SendToCOM uses the serial port to communicate with expansion module. To use the 

SendToCOM, you can send data to expansion module through the serial port, and receive data 

from other device through the serial port. 

 

For more information about these commands for communicating with expansion module, please 

refer to: 

http://www.icpdas.com/root/product/solutions/remote_io/rs-485/i-8k_i-87k/i-8k_i-87k_selection.

html#b 

 

 

http://www.icpdas.com/root/product/solutions/remote_io/rs-485/i-8k_i-87k/i-8k_i-87k_selection.html#b
http://www.icpdas.com/root/product/solutions/remote_io/rs-485/i-8k_i-87k/i-8k_i-87k_selection.html#b
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3.8. RegEdit 

The RegEdit provides a hierarchical representation of the registry on a target computer, similar in 

appearance to the Windows Registry Editor. The standard registry roots are represented; you can 

add keys beneath a root to point to existing registry keys, or you can add your own keys. Values can 

be changed for existing keys, or added for new keys, and default keys can be specified.  
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3.9. ISQLW35 

The ISQLW35 is a Windows Embedded Compact 6 functionality that implements SQL Server 

Compact 3.5 Query. 
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3.10. INotepad 

The INotepad is a common text-only editor. The resulting files have no format tags or styles. 
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4. Your First XP-8000-CE6 Program 

This chapter provides a guided tour that describes the steps needed to set-up a development 

environment, download, install, configure for user programming with XP-8000-CE6. 

 

 

 

4.1. Setting up the Development Environment 

Before writing your first program, ensure that you have the necessary development tool and the 

corresponding SDKs are installed on your system. 
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4.1.1. Preparing the Development Tools 

XP-8000-CE6 has .NET Compact Framework 3.5 installed. Visual Studio takes full advantage of 

the .NET Compact Framework, which uses public Internet standards to enable integration with 

new and existing applications running on any platform. 

 

Supported languages include  

● Visual Basic.NET 

● Visual C# 

● Visual C++ 

 

 

Tips & Warnings 

1. There is no support for development of both managed and unmanaged code on 

XP-8000-CE6 platform in VS2010/VS2012. 

2. WinCE-based platform development is only supported in Visual studio Professional 

edition or better, no Express or Standard edition. 

 

 

 

The table below provides a summary of the supported development tools and languages required 

for developing XP-8000-CE6 applications. 

 

Language 

Development Tool 

Visual 

Basic .Net 
Visual C# Visual C++ 

Visual Studio 

2005 or earlier 

Any version except 

Professional 
-- -- -- 

Professional √ √ √ 

Visual Studio 

2008 

Any version except 

Professional 
-- -- -- 

Professional √ √ √ 

Visual Studio 

2010 or later 

Any version except 

Professional 
-- -- -- 

Professional -- -- -- 

√: Supported, --: Unsupported 
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4.1.2. Installing the XP-8000-CE6 SDK 

The XP-8000-CE6 SDK offers several APIs for customizing the standard features and integrating with 

other applications, devices and services. 

 

Step 1: Get the latest version of the XP-8000-CE6 SDK 

The XP-8000-CE6 SDK can be found from the CD that was provided with the package or by 

downloading the latest version from ICP DAS web site. 

CD:\XP-8X3X-CE6\SDK\PlatformSDK\ 

http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/sdk/platformsdk/ 

 

File name: PACSDK_CE_n.n.n_Vxxxx.msi 

 n.n.n : platform sdk version number 

 xxxx: 2005 indicates VS2005, 2008 indicates VS2008 

 

Step 2: Execute the PACSDK_CE_n.n.n_Vxxxx.msi 

Follow the prompts until the installation process is complete. 

 

http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/sdk/platformsdk/
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4.2. First XP-8000-CE6 Program in VB.NET 

The best way to learn programming with XP-8000-CE6 is to actually create a XP-8000-CE6 program.  

 

The example below demonstrates how to create a demo program running on XP-8000-CE6 with 

VB.NET. 

 

To create a demo program with VB.NET that includes the following main steps: 

 

1. Create a new project 

2. Specify the path of the PAC reference 

3. Add the control to the form 

4. Add the event handling for the control 

5. Upload the application to XP-8000-CE6 

6. Execute the application on XP-8000-CE6 

 

All main steps will be described in the following subsection. 

 

In this tutorial, we will assume that you have installed XP-8000-CE6 SDK on PC and used the Visual 

Studio 2008 for application development. 
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4.2.1. Create a new project 

The Visual VB.net project template is a composite control that you use in this example creates a 

new project with this user control. 

 

 

Step 1: Start Visual Studio 2008 

 

 

 

Step 2: On the File menu, point to New, and then click Project 
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Step 3: In the Project types pane, expand Visual Basic node and select Smart Device 

Step 4: In the list of Templates, select Smart Device Project 

Step 5: Specify a name and a location for the application and then click OK 
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Step 6: In the Target platform, select Windows CE 

Step 7: In the .NET Compact Framework version, select .NET Compact Framework 
Version 3.5.  

Step 8: In the list of templates, select Device Application. Click OK 
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4.2.2. Specify the path of the PAC reference 

The PAC SDK provides a complete solution to integrate with XP-8000-CE6 and it’s compatible with 

Visual C#, Visual Basic.NET and C++. In order to use a component in your application, you must first 

add a reference to it. 

 

 

Step1: Get the PACNET.dll 

 

 

 

 

The PACNET.dll can be found from the CD that was provided with the package or by downloading the 

latest version from ICP DAS web site. 

CD:\XP-8X3X-CE6\SDK\XPacNET\PACNET\ 

http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/sdk/xpacnet/pacnet/ 

 

Step 2: On the Project menu, and then click Add Reference… 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/sdk/xpacnet/pacnet/
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Step 3: On the Browse tab and browse to where the PACNET.dll are installed, and then 
click OK 
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4.2.3. Add the control to the form 

You can drag various controls from the Toolbox onto the form. These controls are not really "live"; 

they are just images that are convenient to move around on the form into a precise location. 

 

After you add a control to your form, you can use the Properties window to set its properties, such 

as background color and default text. The values that you specify in the Properties window are the 

initial values that will be assigned to that property when the control is created at run time. 

 

 

Step 1: On the Toolbox panel, drag a Button control onto the form 

‘ 
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Step 2: On the Properties panel, type Check the SDK version in the Text field 
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4.2.4. Add the event handling for the control 

You have finished the design stage of your application and are at the point when you can start 

adding some code to provide the program's functionality. 

 

 

Step 1: Double-click the button on the form 

 

 

 

 

 

 

 

Step 2: Inserting the following code 

 

Dim data(30) As Byte 

PACNET.Sys.GetSDKVersion(data) 

MessageBox.Show(PACNET.MISC.WideString(data)) 

 

 

 

 

 

 

 

 

 

 

Tips & Warnings 

The “PACNET” of “using PACNET” is case- sensitive. 
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4.2.5. Upload the application to XP-8000-CE6 

XP-8000-CE6 supports FTP server service. You can upload files to XP-8000-CE6 or download files 

from a public FTP server. 

 

 

 

 

 

 

 

 

Step 1: On the Build menu, and then click Build [Project Name] 
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Step 2: Open the browser and type the IP address of XP-8000-CE6 

 

Step 3: Upload the application and the corresponding PACNET.dll files to XP-8000-CE6 

 

 

Tips & Warnings 

For applications programming in C# and VB.net with .net compact framework, when 

executing these application on XP-8000-CE6, the corresponding PACNET.dll must be in the 

same directory as the .exe file. 
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4.2.6. Execute the application on XP-8000-CE6 

After uploading the application to XP-8000-CE6, you can just double-click it on XP-8000-CE6 to 

execute it. 
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4.3. First XP-8000-CE6 Program in Visual C# 

The best way to learn programming with XP-8000-CE6 is to actually create a XP-8000-CE6 program.  

 

The example below demonstrates how to create a demo program running on XP-8000-CE6 with 

Visual C#. 

 

To create a demo program with Visual C# that includes the following main steps: 

 

1. Create a new project 

2. Specify the path of the PAC reference 

3. Add the control to the form 

4. Add the event handling for the control 

5. Upload the application to XP-8000-CE6 

6. Execute the application on XP-8000-CE6 

 

All main steps will be described in the following subsection. 

 

In this tutorial, we will assume that you have installed XP-8000-CE6 SDK on PC and used the Visual 

Studio 2008 for application development. 
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4.3.1. Create a new project 

The Visual C# project template is a composite control that you use in this example creates a new 

project with this user control. 

 

 

Step 1: Start Visual Studio 2008 

 

 

 

Step 2: On the File menu, point to New, and then click Project 
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Step 3: In the Project types pane, expand Visual C# node and select Smart Device 

Step 4: In the list of Templates, select Smart Device Project 

Step 5: Specify a name and a location for the application and then click OK 
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Step 6: In the Target platform, select Windows CE 

Step 7: In the .NET Compact Framework version, select .NET Compact Framework 
Version 3.5.  

Step 8: In the list of templates, select Device Application. Click OK 
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4.3.2. Specify the path of the PAC reference 

The PAC SDK provides a complete solution to integrate with XP-8000-CE6 and it’s compatible with 

Visual C#, Visual Basic.NET and C++. In order to use a component in your application, you must first 

add a reference to it. 

 

 

Step1: Get the PACNET.dll 

 

 

 

 

The PACNET.dll can be found from the CD that was provided with the package or by downloading the 

latest version from ICP DAS web site. 

CD:\XP-8X3X-CE6\SDK\XPacNET\PACNET\ 

http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/sdk/xpacnet/pacnet/ 

 

Step 2: On the Project menu, and then click Add Reference… 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/sdk/xpacnet/pacnet/
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Step 3: On the Browse tab and browse to where the PACNET.dll are installed, and then 
click OK 
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4.3.3. Add the control to the form 

You can drag various controls from the Toolbox onto the form. These controls are not really "live"; 

they are just images that are convenient to move around on the form into a precise location. 

 

After you add a control to your form, you can use the Properties window to set its properties, such 

as background color and default text. The values that you specify in the Properties window are the 

initial values that will be assigned to that property when the control is created at run time. 

 

 

Step 1: On the Toolbox panel, drag a Button control onto the form 
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Step 2: On the Properties panel, type Check the SDK version in the Text field 
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4.3.4. Add the event handling for the control 

You have finished the design stage of your application and are at the point when you can start 

adding some code to provide the program's functionality. 

 

 

Step 1: Double-click the button on the form 

 

 

 

 

 

 

Step 2: Inserting the following code 

 

byte[] data = new byte[30]; 

PACNET.Sys.GetSDKVersion(data); 

MessageBox.Show(PACNET.MISC.WideString(data)); 

 

 

 

 

 

 

 

 

 

 

 

Tips & Warnings 

The “PACNET” of “using PACNET” is case- sensitive. 
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4.3.5. Upload the application to XP-8000-CE6 

XP-8000-CE6 supports FTP server service. You can upload files to XP-8000-CE6 or download files 

from a public FTP server. 

 

 

 

 

 

 

 

 

 

Step 1: On the Build menu, and then click Build [Project Name] 
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Step 2: Open the browser and type the IP address of XP-8000-CE6 

 

Step 3: Upload the application and the corresponding PACNET.dll files to XP-8000-CE6 

 

 

Tips & Warnings 

For applications programming in C# and VB.net with .net compact framework, when 

executing these application on XP-8000-CE6, the corresponding PACNET.dll must be in the 

same directory as the .exe file. 
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4.3.6. Execute the application on XP-8000-CE6 

After uploading the application to XP-8000-CE6, you can just double-click it on XP-8000-CE6 to 

execute it. 
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4.4. First XP-8000-CE6 Program in Visual C++ 

The best way to learn programming with XP-8000-CE6 is to actually create a XP-8000-CE6 program.  

 

The example below demonstrates how to create a demo program running on XP-8000-CE6 with 

Visual C++. 

 

To create a demo program with Visual C# that includes the following main steps: 

 

1. Create a new project  

2. Configure the Platform 

3. Include the Header files and Libraries of the PAC SDK 

4. Add the control to the form 

5. Add the event handling for the control 

6. Upload the application to XP-8000-CE6 

7. Execute the application on XP-8000-CE6 

 

All main steps will be described in the following subsection. 

 

In this tutorial, we will assume that you have installed XP-8000-CE6 SDK on PC and used the Visual 

Studio 2008 for application development. 
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4.4.1. Create a new project 

The Visual C# project template is a composite control that you use in this example creates a new 

project with this user control. 

 

 

Step 1: Start Visual Studio 2008 

 

 

 

Step 2: On the File menu, point to New, and then click Project 
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Step 3: In the Project types pane, expand Visual C++ node and select Smart Device 

Step 4: In the list of Templates, select MFC Smart Device Application 

Step 5: Specify a name and a location for the application and then click OK 
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Step 6: On the first page of the wizard, click Next 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 7: On the next page of the wizard, select XPacSDK_CE to be added to the project, 
and then click Next 
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Step 8: On the next page of the wizard, select Dialog based, and then click next 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 9: On the next page of the wizard, click next 
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Step 10: On the next page of the wizard, click next 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 11: On the next page of the wizard, click Finish 
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4.4.2. Configure the Platform 

When developing applications by using Visual C++, you must configure the Platform to indicate 

what platform and device you intend to download the application to. Before you deploy your 

project, check the platform. 

 

On the Debug configuration toolbar, select Release and select XPacSDK_CE(x86) as shown in the 

following illustration. 
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4.4.3. Specify the Libraries of the PAC SDK 

The PAC SDK provides the PACSDK libraries with XP-8000-CE6. 

It’s compatible with C++. In order to use a component in your application, you must first add a 

reference to it. 

 

 

Step 1: On the View menu, and then click Property Pages 
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Step 2: In left pane, click Linker, and then click Input 

Step 3: In the right pane, Type PACSDK.lib in the Additional Dependencies item 
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4.4.4. Add the control to the form 

You can drag various controls from the Toolbox onto the form. These controls are not really "live"; 

they are just images that are convenient to move around on the form into a precise location. 

 

After you add a control to your form, you can use the Properties window to set its properties, such 

as background color and default text. The values that you specify in the Properties window are the 

initial values that will be assigned to that property when the control is created at run time. 

 

 

Step 1: On the View menu, and then click Resource View 
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Step 2: In the Resource View Panel, Expand the [Project name].rc file and then expand 
the Dialog item to click the plug-in dialog 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 3: On the Toolbox panel, drag a Button control onto the form 
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Step 4: On the Properties panel, type Check the SDK version in the Caption field 
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4.4.5. Add the event handling for the control 

You have finished the design stage of your application and are at the point when you can start 

adding some code to provide the program's functionality. 

 

 

Step 1: Double-click the button on the form 

 

 

 

 

 

 

 

 

 

 

 

Step 2: Inserting the following code 

char sdk_version[32]; 

TCHAR buf[32]; 

pac_GetSDKVersion(sdk_version); 

pac_AnsiToWideString(sdk_version, buf); 

MessageBox(buf,0,MB_OK); 
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Step 2: Inserting the following code into the header area 

#include “PACSDK.h” 
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4.4.6. Upload the application to XP-8000-CE6 

XP-8000-CE6 supports FTP server service. You can upload files to XP-8000-CE6 or download files 

from a public FTP server. 

 

 

 

 

 

 

 

 

Step 1: On the Build menu, and then click Build [Project Name] 
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Step 2: Open the browser and type the IP address of XP-8000-CE6 

 

Step 3: Upload the application to XP-8000-CE6 
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4.4.7. Execute the application on XP-8000-CE6 

After uploading the application to XP-8000-CE6, you can just double-click it on XP-8000-CE6 to 

execute it. 
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5. I/O Expansion Modules and SDKs Selection 

This chapter describes how to select a suitable expansion I/O module and the corresponding SDK 

library to be used for developing programs on XP-8000-CE6. 

 

XP-8000-CE6 provides the following I/O expansion buses: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

M-7K I-7K RU-87Pn 

RS-485 

 

ET-7K ET-87Pn 

 
Ethernet 

 

I-8K/I-87K series I/O modules 

CAN Bus 

FRnet I-8172W 

I-8120 

FRnet series I/O modules 

CAN Bus series I/O modules 

Local I/O 

 

 

I/O Slot 
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1. RS-485 

I-7000, M-7000, RU-87Pn and high profile I-87K series modules connect to XP-8000-CE6 via a 

twisted-pair, multi-drop, 2-wire RS-485 network. 

 

 

 I-7000 series I/O module 

Module Native SDK .NET CF SDK 

I-7000 series PACSDK.dll PACNET.dll 

I-7000 series with I-7088 (D) PACSDK_PWM.dll PACNET.dll 

 

For full details regarding I-7000 series I/O modules and its demos, please refer to: 

http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/demo/xpac/applicabled_demo_for_7k_module.pdf 

 

 

 M-7000 series I/O module 

Module Native SDK .NET CF SDK 

M-7000 series Modbus Demo Modbus Demo 

 

For more detailed information about M-7000 series modules using Modbus protocol and its demos, 

please refer to: 

http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/demo/nmodbus/ 

 

 

 RU-87Pn + I-87K series I/O module 

Module Native SDK .NET CF SDK 

RU-87Pn+I-87K series PACSDK.dll PACNET.dll 

 

 

 Other Specified I/O 

Module Native SDK .NET CF SDK 

Others PACSDK.dll PACNET.dll 

 

 

 

http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/demo/xpac/applicabled_demo_for_7k_module.pdf
http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/demo/nmodbus/
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2. Ethernet  

The Ethernet I/O devices available include ET-7000and I-8KE4/8-MTCP, and support either the 

DCON or the Modbus/TCP communication protocol. 

 

Module Native SDK .NET CF SDK 

M-7000 series Modbus Demo Modbus Demo 

I-8KE4/8-MTCP Modbus Demo Modbus Demo 

 

For more detailed information about ET-7000 and I-8KE4/8-MTCP series modules using 

Modbus protocol and its demos, please refer to: 

http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/demo/nmodbus/ 

 

 

3. Local I/O  

XP-8000-CE6 has 0/1/3/7 expansion slot(s) that can be used to add expansion I/O modules. The 

expansion I/O modules can be divided into two categories: High Profile I-8K series I/O modules and 

High profile I-87K series I/O modules. The following indicates the appropriate SDK library to be 

used for I/O modules. 

 

 General I-8K/I-87K series I/O module 

Module Native SDK .NET CF SDK 

I-8K series PACSDK.dll PACNET.dll 

I-87K series PACSDK.dll PACNET.dll 

 

For full details regarding I-87K series I/O modules and its demos, please refer to: 

http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/demo/xpac/applicabled_demo_for_87k_module.pdf 

 

 

 

 

 

 

 

 

 

http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/demo/nmodbus/
http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/demo/xpac/applicabled_demo_for_87k_module.pdf
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 Other Specified I/O 

Module Native SDK .NET CF SDK 

I-8014W pac_i8014W.dll pac_i8014WNET.dll 

I-8017HW pac_i8017HW.dll pac_i8017HWNET.dll 

I-8024W pac_i8024W.dll pac_i8024WNET.dll 

I-8026W pac_i8026W.dll pac_i8026WNET.dll 

I-8048W pac_i8048W.dll pac_i8048WNET.dll 

I-8050W pac_i8050W.dll pac_i8050WNET.dll 

I-8084W pac_i8084W.dll pac_i8084WNET.dll 

I-8088W pac_i8088W.dll pac_i8088WNET.dll 

I-8093W pac_i8093W.dll pac_i8093WNET.dll 

I-87088W PACSDK_PWM.dll PACNET.dll 

 

 

4. FRnet  

FRnet is an innovative industrial field bus technology that uses twisted pair cable as the 

transmission medium. The status of all I/O devices is updated on a fixed cycle, no matter how 

many FRnet I/O modules are connected to the FRnet network. 

 

Module Native SDK .NET CF SDK 

I-8172W pac_i8172W.lib pac8172WNet.dll 

 

 

5. CAN Bus 

The Controller Area Network (CAN) is a serial communication way, which efficiently supports 

distributed real-time control with a very high level of security. It provides the error-processing 

mechanisms and concepts of message priority. These features can improve the network reliability 

and transmission efficiency. 

 

Module Native SDK .NET CF SDK 

I-8120W i8120.lib i8120net_pac.dll 
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6. APIs and Demo References 

This chapter provides a brief overview of PAC standard APIs and demos that have been designed 

for XP-8000-CE6 from the PAC SDK package. 

 

 

ICP DAS provides a set of demos in different programming languages. You can examine the demo 

codes, which includes numerous comments, to familiarize yourself with the PAC APIs. This will 

allow developing your own applications quickly by modifying these demo programs. 

 

For full usage information regarding the description, prototype and the arguments of the functions, 

please refer to the “PAC Standard API Manual” 
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6.1. PAC Standard APIs for System Operation 

The diagram below shows the set of each system operation API provided in the PACSDK. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

System Operation 

 System Information 

 Backplane Access 

 Backlight 

 Interrupt 

 Memory Access 

 Watchdog 

 UART 

 Registry 

 Buzzer 

 LED 
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6.1.1. VB.NET Demos for PAC Standard APIs 

The PAC SDK includes the following demos that demonstrate the use of the PAC Standard APIs in a 

VB.NET language environment.  

 

The following demos can be found on the CD that was provided with the package or by 

downloading the latest version from ICP DAS web site. 

CD:\XP-8X3X-CE6\demo\XPAC\VB.NET\Standard\ 

http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/demo/xpac/vb.net/standard/ 

 

Folder Demo Explanation 

BPtimer BPtimer Retrieves information about the hardware timer. 

DeviceInformation DeviceInformation 
Retrieves information about the OS version, CPU 

version, SDK version, etc. 

Diagnostic Diagnostic 
Retrieves information about the slot count and the 

module inserted in the backplane. 

DIP DIP Retrieves information about the status of the DIP switch. 

GetRotaryID GetRotaryID 
Retrieves information about the status of the rotary 

switch. 

Memory Memory 
Shows how to read/write data values from/to the 

EEPROM or the backplane of the SRAM 

RealTimeTest RealTimeTest 

Writes the managed cod for the rich graphical user 

interface that does not require true real-time 

performance 

Registry Registry 
Shows how to read/write data values from/to the 

registry. 

UART UART 
Shows how to read the name of the local I/O module via 

a UART. 

WatchDog WatchDog 
Displays information about how to operate the 

watchdog. 

http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/rescue/ce6/
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6.1.2. C# Demos for PAC Standard APIs 

The PAC SDK includes the following demos that demonstrate the use of the PAC Standard APIs in a 

C# language environment.  

 

The following demos can be found on the CD that was provided with the package or by 

downloading the latest version from ICP DAS web site. 

CD:\XP-8X3X-CE6\demo\XPAC\C#\Standard\ 

http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/demo/xpac/c%23/standard/ 

 

Folder Demo Explanation 

BPtimer BPtimer Retrieves information about the hardware timer. 

DeviceInformation DeviceInformation 
Retrieves information about the OS version, CPU 

version, SDK version, etc. 

Diagnostic Diagnostic 
Retrieves information about the slot count and the 

module inserted in the backplane. 

DIP DIP Retrieves information about the status of the DIP switch. 

GetRotaryID GetRotaryID 
Retrieves information about the status of the rotary 

switch. 

Memory Memory 
Shows how to read/write data values from/to the 

EEPROM or the backplane of the SRAM 

RealTimeTest RealTimeTest 

Writes the managed cod for the rich graphical user 

interface that does not require true real-time 

performance 

Registry Registry 
Shows how to read/write data values from/to the 

registry. 

UART UART 
Shows how to read the name of the local I/O module via 

a UART. 

WatchDog WatchDog 
Displays information about how to operate the 

watchdog. 

http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/rescue/ce6/
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6.1.3. Visual C++ Demos for PAC Standard APIs 

The PAC SDK includes the following demos that demonstrate the use of the PAC Standard APIs in a 

Visual C++ language environment.  

 

The following demos can be found on the CD that was provided with the package or by 

downloading the latest version from ICP DAS web site. 

CD:\XP-8X3X-CE6\demo\XPAC\VC2005\Standard\ 

http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/demo/xpac/vc2005/standard/ 

 

Folder Demo Explanation 

BPtimer BPtimer Retrieves information about the hardware timer. 

DeviceInformation DeviceInformation 
Retrieves information about the OS version, CPU 

version, SDK version, etc. 

Diagnostic Diagnostic 
Retrieves information about the slot count and the 

module inserted in the backplane. 

DIP DIP Retrieves information about the status of the DIP switch. 

GetRotaryID GetRotaryID 
Retrieves information about the status of the rotary 

switch. 

Memory Memory 
Shows how to read/write data values from/to the 

EEPROM or the backplane of the SRAM 

RealTimeTest RealTimeTest 

Writes the managed cod for the rich graphical user 

interface that does not require true real-time 

performance 

Registry Registry 
Shows how to read/write data values from/to the 

registry. 

UART UART 
Shows how to read the name of the local I/O module via 

a UART. 

WatchDog WatchDog 
Displays information about how to operate the 

watchdog. 

http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/demo/xpac/vc2005/standard/
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PAC IO 

Local I/O Remote I/O 

6.2. PAC Standard APIs for PAC Expansion I/O 

The diagram below shows the types of the PAC IO APIs provided in the PACSDK. 
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6.2.1. VB.net Demos for PAC Expansion I/O 

The PAC SDK includes the following demos that demonstrate the use of the PAC expansion I/O in a 

VB.NET language environment.  

 

 

The following demos can be found on the CD that was provided with the package or by 

downloading the latest version from ICP DAS web site. 

CD:\XP-8X3X-CE6\demo\XPAC\VB.NET\IO\ 

http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/demo/xpac/vb.net/io/ 

 

 

Folder Demo Explanation 

Local 

find_io 
Shows how to retrieve the module name and type which plugged 

in the XP-8000-CE6. 

8k_di 
Shows how to read the DI values of DI module. 

This demo program is used by 8K series DI modules. 

8k_do 
Shows how to write the DO values to DO module. 

This demo program is used by 8K series DO modules. 

8k_dio 
Shows how to read the DI and the DO values of the DIO module.  

This demo program is used by 8K series DIO modules. 

87k_basic 
Shows how to send/receive a command/response application. 

This demo program is used by 87K series modules. 

87K_demo 
Shows how use uart API and the IO modules located as slots.  

This demo program is used by 87K series modules. 

87k_ai 
Shows how to read the AI values of AI module. 

This demo program is used by 87K series AI modules. 

87k_ao 
Shows how to write the AO values to AO module. 

This demo program is used by 87K series AO modules. 

87k_di 
Shows how to read the DI values of DI module. 

This demo program is used by 87K series DI modules. 

Local 

87k_do 
Shows how to write the DO values to DO module. 

This demo program is used by 87K series DO modules. 

87k_dio 

Shows how to read the DI and the DO values of the  

DIO module. 

This demo program is used by 87K series DIO modules. 

Remote 7k87k_basic 

Shows how to send/receive a command/response application. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/demo/xpac/vb.net/io/
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Folder Demo Explanation 

7k87k_ai 

Shows how to read the AI values of AI module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_ao 

Shows how to write the AO values to AO module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_di 

Shows how to read the DI values of DI module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_do 

Shows how to write the DO values to DO module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_dio 

Shows how to read the DI and the DO values of the DIO module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 
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6.2.2. C# Demos for PAC Expansion I/O 

The PAC SDK includes the following demos that demonstrate the use of the PAC expansion I/O in a 

C# language environment.  

 

 

The following demos can be found on the CD that was provided with the package or by 

downloading the latest version from ICP DAS web site. 

CD:\XP-8X3X-CE6\demo\XPAC\C#\IO\ 

http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/demo/xpac/c%23/io/ 

 

 

Folder Demo Explanation 

Local 

find_io 
Shows how to retrieve the module name and type which plugged 

in the XP-8000-CE6. 

8k_di 
Shows how to read the DI values of DI module. 

This demo program is used by 8K series DI modules. 

8k_do 
Shows how to write the DO values to DO module. 

This demo program is used by 8K series DO modules. 

8k_dio 
Shows how to read the DI and the DO values of the DIO module.  

This demo program is used by 8K series DIO modules. 

87k_basic 
Shows how to send/receive a command/response application. 

This demo program is used by 87K series modules. 

87K_demo 
Shows how use uart API and the IO modules located as slots.  

This demo program is used by 87K series modules. 

87k_ai 
Shows how to read the AI values of AI module. 

This demo program is used by 87K series AI modules. 

87k_ao 
Shows how to write the AO values to AO module. 

This demo program is used by 87K series AO modules. 

87k_di 
Shows how to read the DI values of DI module. 

This demo program is used by 87K series DI modules. 

Local 

87k_do 
Shows how to write the DO values to DO module. 

This demo program is used by 87K series DO modules. 

87k_dio 

Shows how to read the DI and the DO values of the  

DIO module. 

This demo program is used by 87K series DIO modules. 

Remote 7k87k_basic 

Shows how to send/receive a command/response application. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/demo/xpac/c%23/io/
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Folder Demo Explanation 

7k87k_ai 

Shows how to read the AI values of AI module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_ao 

Shows how to write the AO values to AO module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_di 

Shows how to read the DI values of DI module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_do 

Shows how to write the DO values to DO module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_dio 

Shows how to read the DI and the DO values of the DIO module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 
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6.2.3. Visual C++ Demos for PAC Expansion I/O 

The PAC SDK includes the following demos that demonstrate the use of the PAC expansion I/O in a 

C# language environment.  

 

 

The following demos can be found on the CD that was provided with the package or by 

downloading the latest version from ICP DAS web site. 

CD:\XP-8X3X-CE6\demo\XPAC\VC2005\IO\ 

http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/demo/xpac/vc2005/io/ 

 

 

Folder Demo Explanation 

Local 

find_io 
Shows how to retrieve the module name and type which plugged 

in the XP-8000-CE6. 

8k_di 
Shows how to read the DI values of DI module. 

This demo program is used by 8K series DI modules. 

8k_do 
Shows how to write the DO values to DO module. 

This demo program is used by 8K series DO modules. 

8k_dio 
Shows how to read the DI and the DO values of the DIO module.  

This demo program is used by 8K series DIO modules. 

87k_basic 
Shows how to send/receive a command/response application. 

This demo program is used by 87K series modules. 

87K_demo 
Shows how use uart API and the IO modules located as slots.  

This demo program is used by 87K series modules. 

87k_ai 
Shows how to read the AI values of AI module. 

This demo program is used by 87K series AI modules. 

87k_ao 
Shows how to write the AO values to AO module. 

This demo program is used by 87K series AO modules. 

87k_di 
Shows how to read the DI values of DI module. 

This demo program is used by 87K series DI modules. 

Local 

87k_do 
Shows how to write the DO values to DO module. 

This demo program is used by 87K series DO modules. 

87k_dio 

Shows how to read the DI and the DO values of the  

DIO module. 

This demo program is used by 87K series DIO modules. 

Remote 7k87k_basic 

Shows how to send/receive a command/response application. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/demo/xpac/vc2005/io/
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Folder Demo Explanation 

7k87k_ai 

Shows how to read the AI values of AI module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_ao 

Shows how to write the AO values to AO module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_di 

Shows how to read the DI values of DI module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_do 

Shows how to write the DO values to DO module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_dio 

Shows how to read the DI and the DO values of the DIO module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 
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7. Recovery and Restore 

This chapter provides information of the XP-8000-CE6 restore and recovery, and a guided tour that 

describes the steps needed to restore and recovery the XP-8000-CE6. 

 

The XP-8000-CE6 comes with a rescue CF card that can be used to not only boot the XP-8000-CE6 

when the OS fails to load, but also recover files. 

 

The recovery file of the rescue CF card can be found separately on the CD that was provided with 

the package or by downloading the latest version from ICP DAS web site. 

 

CD:\XP-8X3X-CE6\Rescue_Disk\ 

http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/rescue_disk/ 

 

 

 

 

 

 

 

 

http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/rescue_disk/
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7.1. Recovering the XP-8000-CE6 

If the XP-8000-CE6 crashes and won’t start up, you can use the rescue CF card to start up the 

XP-8000-CE6 and then fix the problem that caused the crash. 

 

 

Step 1: Plug the CF card in CF slot and turn the rotary switch in position 0 

 

 

 

 

 

 

 

 

Step 2: Reboot the XP-8000, press Delete key to enter the BIOS setup utility 

Step 3: On the Advanced menu, select USB Configuration and then press Enter key 

 

BIOS SETUP UTILITY 

Main Advanced PCIPnP Boot Security Exit  

► Advanced Settings Configure the USB support 

WARNINGS: Setting wrong values in below sections 

may cause system to malfunction. 

► IDE Configuration 

► Serial/Parallel Port Configuration 

► Remote Access Configuration 

► USB Configuration 

► Power Management Configuration 

► Smbios Configuration 
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Step 4: Set Legacy USB Support as Enabled, it means enable the USB legacy support 

 

BIOS SETUP UTILITY 

Main Advanced PCIPnP Boot Security Exit  

► USB Configuration Enables support for 

legacy USB. Auto 

option disables 

legacy support if no 

USB devices are 

connected. 

Module Version – x.x.x-xx.x 

USB Devices Enabled : 1 

1 Keyboard 

USB Support [Enabled] 

Legacy USB Support [Enabled] 

Reset USB HC Support [Disabled] 

Support USB Device Wakeup [Disabled] 

 

 

Step 5: Select F10 key and select OK to exit the BIOS Setup Utility and reboot the 
XP-8000-CE6 

 

Step 6: Reboot the XP-8000-CE6, press F10 key to enter the Boot menu 

Step 7: On the Boot menu, select HDD：PM-InnoDisk Corp.  iCF 1ME 16 and then press 
Enter key 

 

Please select boot device: 

HDD：PM-InnoDisk Corp.  iCF 1ME 16 

SATA：SM-InnoDisk Corp.  – mSATA 3 

↑and↓ to move selection 

ENTER to select boot device 

ESC to boot using defaults 
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Step 8: Enter 1, (1) create XPAC_CE default partition  

Wait a while until we enter the XP-8000-CE6 Rescue Utility again. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 9: Enter 2, (2) format and restore XPAC_CE to factory default OS. 

Wait a while until we enter the XP-8000-CE6 Rescue Utility again. 
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Step 10: Enter 3, (3) reboot 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 13: Repeat step 2 to step 6 to set Legacy USB Support as Disabled 

 

BIOS SETUP UTILITY 

Main Advanced PCIPnP Boot Security Exit  

► USB Configuration Enables support for 

legacy USB. Auto 

option disables 

legacy support if no 

USB devices are 

connected. 

Module Version – x.x.x-xx.x 

USB Devices Enabled : 1 

1 Keyboard 

USB Support [Enabled] 

Legacy USB Support [Disabled] 

Reset USB HC Support [Disabled] 

Support USB Device Wakeup [Disabled] 

 

 

Step 14: The XP-8000-CE6 has been recovered 



XP-8000-CE6 User Manual (for WinCE 6.0 Based XPAC), version 1.0.5         Page: 139 

Copyright ©  2018 ICP DAS Co., Ltd. All Rights Reserved.   E-mail: service@icpdas.com 

 

7.2. Restoring the Rescue CF Card 

The rescue CF card is rescue equipment that allows you to perform some maintenance tasks on 

your system in case of failure. 

Once the rescue CF card are partitioned or formatted, you must restore the rescue CF card. 

 

Requirements 

For restoring the Rescue CF card, you should prepare Ghost 11 or later, which you could obtain by 

contacting Symantec (http://www.symantec.com) 

 

Here are step by step instructions on how to restore the rescue CF card. In this demonstration, we 

will use Symantec Norton Ghost32 V.11.0 (The Symantec Norton Ghost V.11 or above version are 

recommend). 

 

 

Step 1: Get the latest version of rescue ghost file, rescue.gho 

The latest version of rescue.gho file can be found by downloading the latest version 

from ICP DAS web site. 

http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/rescue_disk/ 

 

 

Step 2: Start the Symantec Norton Ghost32 V.11, and then click OK 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.symantec.com/
http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/rescue_disk/
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Step 3: Click Function Menu, point to Local, point to Disk, and then click From Image 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 4: Select the rescue ghost file that you saved, and then click Open 
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Step 5: Select the destination to CF card and click then OK 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 6: Recovery the rescue ghost file into CF card and then click OK 
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Step 7: The rescue CF card has been done 
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8. XP-8000-CE6 Updates 

This chapter provides a guided tour that demonstrates the steps needed to update the 

XP-8000-CE6 OS and SDKs. 

 

ICP DAS will continue to add additional features to XP-8000-CE6 SDK and OS in the future, so we 

advise you to periodically check the ICP DAS web site for the latest updates. 

 

 

The file location of the OS and SDK 

Both the files of OS updates and SDK updates can be found on the CD that was provided with the 

package or by downloading the latest version from ICP DAS web site. 

 

▪ For XP-8x31-CE6: 

   CD:\XP-8X3X-CE6\ 

   http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/ 

RESCUE 

SDK 

NAPOPC_CE6 

nModbus 

PlatformSDK 

Special_IO 

XPacNET 

XPACSDK 

The files of OS updates 

The files of SDK updates 
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8.1. OS updates 

OS updates are part of the XP-8000-CE6 updates services to provide additional and more efficient 

features and functionality for XP-8000-CE6 operating system. 

 

There are two ways to update the OS: 

1. Update from file (Please refer to section 8.1.1) 

 (We recommend that you use this one for more quicker and easier to update) 

2. Update from rescue CF card (Please refer to section 8.1.2) 
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8.1.1. OS Updates from file 

The OS update file can be obtained via the network. Before updating the 

OS, make sure the XP-8000-CE6 is connected to the network. 

 

 

 

Step 1: Get the latest version of the OS image file, NK.bin 

The latest version of the OS image file, NK.bin, can be found from ICP DAS web site. 

http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/rescue/ce6/ 

 

Step 2: Replace an old one OS with a new one 

The OS image, NB.bin are pre-installed on the \System_Disk 

 

Step 3: Reboot the XP-8000-CE6, the OS image has been updated completely 

Run the XPAC Utility, click Reboot from the File menu for changes to take effect. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/rescue/ce6/
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Step 4: Check the OS version 

Run the XPAC Utility, and then select the Device Information tab to check the current OS version. 
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8.1.2. OS Updates using the Rescue CF Card 

The XP-8000-CE6 can be reinstalled with the XP-8000-CE6 Rescue Utility. Before reinstalling the 

XP-8000-CE6, make sure the necessary updating files have been are available on your CF card. 

For more information on how to reinstall the XP-8000-CE6, please refer to section 7.1. Recovering 

the XP-8000-CE6 
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8.2. SDK Updates 

SDK update is a part of the XP-8000-CE6 update services to provide additional and more efficient 

features and functionality for XP-8000-CE6 operating system.  

 

 

 

8.2.1. SDK Updates for VB.NET or C# 

The SDK can be updated by replacing the PACNET.dll file. 

 

Step 1: Get the latest version of the PACNET.dll file 

The latest version of the PACNET.dll file can be obtained from ICP DAS web site. 

http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/sdk/xpacnet/pacnet/ 

 

Step 2: Copy the latest version of PACNet.dll file to PC and XP-8000-CE6 

The PACNET.dll file on PC can be placed anywhere only the solution can reference it. 

The PACNET.dll file on XP-8000-CE6 is located at the same directory as the .exe file. 

 

 

Step 3: Reboot the XP-8000-CE6, the SDK has been updated completely 

Run the XPAC Utility, click Reboot from the File menu for changes to take effect. 

 

 

 

 

 

 

 

 

 

 

 

http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/sdk/xpacnet/pacnet/
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Step 4: Check the SDK version 

Run the XPAC Utility, and then select the Device Information tab to check the current SDK version. 
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8.2.2. SDK Updates for VB.NET or Visual C++ 

The SDK can be updated by replacing the PAC SDK files. 

 

 

Step 1: Get the latest version of the VC++ components 

The latest version of the VC++ components can be obtained from:  

http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/sdk/xpacsdk/pacsdk/ 

 

Step 2: Copy the latest version of header files and libraries to PC 

The header files are located at:  

C:\Program Files\Windows CE Tools\wce600\XPacSDK_CE\Include\X86\ 

The libraries are located at:  

C:\Program Files\Windows CE Tools\wce600\XPacSDK_CE\Lib\x86\ 

 

Step 3: Copy the latest version of DLL files to XP-8000-CE6 

The DLL files are located at:  

\System_Disk\ICPDAS\System 

 

Step 4: Reboot the XP-8000-CE6, the SDK has been updated completely 

Run the XPAC Utility, click Reboot from the File menu for changes to take effect. 

 

 

 

 

 

 

 

 

 

 

http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/sdk/xpacsdk/pacsdk/
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Step 5: Check the SDK version 

Run the XPAC Utility, and then select the Device Information tab to check the current SDK version. 
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9. XP-8000-CE6 Download Center 

This chapter provides a brief introduction of the XP-8000 -CE6 download center. 

 

XP-8000 -CE6 has a download center where you can access the latest version of the software, tools, 

demo programs, and related information.  

 

The XP-8000-CE6 Download Center can be found separately at: 

http://www.icpdas.com/root/support/download/download.php 

 

 
 

The categories of updates available from the XPAC Download Center include: 
 

 OS images: This category contains the latest version of the XPAC OS. 
 

 SDK: This category contains the latest version of the SDK for each XPAC component SDK, 

such as XPAC SDK, and Modbus SDK, etc. 

http://www.icpdas.com/root/support/download/download.php
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 Utility & Tools: This category contains the latest version of the XPAC toolkits. 
 

 Demo: This category contains all demo programs related to the XPAC. 
 

 Documents: This category contains the latest versions of documents related to the XPAC. 
 

 System Disk: This category contains the latest version of the XPAC toolkits. 

 FAQ: This category contains answers to some common issues you may encounter while 

troubleshooting the XPAC. 
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10. Application of RS-485 Network 

The RS-485 length can be up to 4000 ft or 1.2 km over a single set of twisted–pair cables, if the 

RS-485 network is over 4000 ft or 1.2Km, the RS-485 repeater must be added to extend the RS-485 

network. 
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10.1. Basic RS-485 Network 

The basic component of the RS-485 network consist of a Master Controller (or using a PC as a host 

controller), and some RS-485 devices. 
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10.2. Daisy Chain RS-485 Network 

All RS-485 devices are wired directly to the main network, If the network is up to 1.2 km, it will 

need a repeater (7510 series) to extend the network length. 
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10.3. Star Type RS-485 Network 

There are branches along the main network. In this case, it is better to have a repeater to isolate or 

filter the noise that is made by devices. 
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There is a better choice to use 7513 as a RS-485 hub on start type network. 
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10.4. Random RS-485 Network 

There are branches along the main wire. In this case, it is better to have a repeater to isolate or 

filter the noise that is made by devices. 
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10.5. Master/Slave Settings 

The RS-485 network based on master-slave architecture consists of a single master device and one 

or more slave devices. 

The XPAC provides two RS-485 communication interfaces based on the master-slave system 

architecture, all of which have a pull-high/pull-low resistor, user can set it to master or slave for 

implementing an RS-485 multi-drop network. 

One of the RS-485 communications, COM3, its pull-high/pull-low resistor located on power board, 

the other, COM4, located on the right side and its pull-high/pull-low resistor located on the bottom 

of the right side, as shown below. 
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10.5.1.  XPAC as a Master (Default) 

When one of XPAC is set to master, then all the other devices on the same network must be slave 

mode. If the network is up to 1.2 KM, it will need a repeater (7510 series) to extend the network 

length. 
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When XPAC as a master using COM3 communication interface, the pull-high/pull-low resistor 

located on the power board must adjust to enable as shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When XPAC as a master using COM4 communication interface, the pull-high/pull-low resistor 

located on the power board must adjust to enable as shown below. 
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10.5.2. XPAC as a Slave 

For most of application, when using one 7520 series as RS-232/485 converter, its pull-high/pull-low 

resistors are set to enabled. Then the XP-8000-CE6 and all the other devices on this network must 

be slave mode (the pull-high/pull-low resistors must be disabled). 

If there are repeaters on the RS-485 network, there will be pull-high/pull-low resistors on both 

sides of the repeaters (I-7510) 
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When XPAC as a master using COM3 communication interface, the pull-high/pull-low resistor 

located on the power board must adjust to enable as shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When XPAC as a master using COM4 communication interface, the pull-high/pull-low resistor 

located on the power board must adjust to enable as shown below. 
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Tips – How to 

This chapter provides tips and a guided tour on using and maintaining the XP-8000. 
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A. How to Use the Printer 

XP-8000-CE6 have ability to access the printer, the printer can be connected via an Ethernet or a 

USB. 

 

 

 

 

 

 

 

 

 

 

Tips & Warnings 

XP-8000-CE6 only supports HP Laser Jet Printers with PCL6 driver. The following printer 

support is released by HP: 

 HP LaserJet 4000 series/HP LaserJet 4100 series 

 HP LaserJet 2100 series/HP LaserJet 2200 series 

 HP LaserJet 1200 

 HP LaserJet 3200/HP LaserJet 3300 

 HP LaserJet 4200 series/HP LaserJet 4300 series 

 HP LaserJet 5000 series/HP LaserJet 5100 series 

 HP LaserJet 8000 series 

 HP LaserJet 9000 series printers 

If you need the latest support of HP PCL6 printer, you can refer to following link 

http://h20000.www2.hp.com/bizsupport/TechSupport/Document.jsp?objectID=bpl04568 

 

 

 

 

http://h20000.www2.hp.com/bizsupport/TechSupport/Document.jsp?objectID=bpl04568
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A.1. How to Use a Network Printer 

Here are step by step instructions on how to use a shared printer.  

 

 

Step 1: On PC side, check the name of the PC and the shared printer 
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Step 2: On XP-8000-CE6 side, run the Notepad, and then open a WordPad format file 

 

 
 

 

 

Step 3: Set up the printer 

1. Printer: PCL Laser 

2. Port: Network 

3. Net Path: \\ServerName\PrinterName 

The “ServerName” is the name or IP of the PC. 

The “PrinterName” is the name of share printer of the PC.  

4. Paper Size: Select the paper size 
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A.2. How to Use a USB printer 

Here are step by step instructions on how to use a USB printer via a USB port.  

 

 

Step 1: Run the Notepad, and then open a WordPad format file 

 

 

 

 

 

 

 

 

 

 

 

Step 2: Set up the printer 

1. Printer: Hewlett-Packard LaserJet 

2. Port: LPT1 

3. Paper Size: Select the paper size 
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B. How to Online Debug the XP-8000-CE6 Program 

Here are step by step instructions on how to online debug the XP-8000-CE6 program. 

 

Tips & Warnings 

Before starting online debug the XP-8000-CE6 program, make sure that the XP-8000-CE6 

SDK has been installed correctly.  

For more information on how to install the XP-8000-CE6 SDK, please refer to 4.1.2. 

Installing the XP-8000-CE6 SDK. 

 

 

Step 1: Copy the following files to the \System_Disk\icpdas\system on the XP-8000 

By default, these files are located on the development computer at C:\Program Files\Common 

Files\Microsoft Shared\CoreCon\1.0\Target\wce400\<CPU>. 

 clientshutdown.exe 

 CMAccept.exe 

 ConmanClient2.exe 

 eDbgTL.dll 

 TcpConnectionA.dll 

Step 2: Run the ConmanClient2.exe and then CMAccept.exe on the XP-8000-CE6 
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Step 3: On the Tools menu, click the Options 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 4: In the left pane, expand Device Tools node and select Devices 

Step 5: In the Show devices for platform:, select XPacSDK_CE and then click Properties 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



XP-8000-CE6 User Manual (for WinCE 6.0 Based XPAC), version 1.0.5         Page: 172 

Copyright ©  2018 ICP DAS Co., Ltd. All Rights Reserved.   E-mail: service@icpdas.com 

 

Step 6: Click the Configure… 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 7: Select the Use specific IP address:, and then type the IP address of XP-8000-CE6 
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Step 8: Click the OK, and then click OK to end the dialog 
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Step 9: On the Tools menu, click the Connect to Device… 

 

 

 

Step 10: Click the Connect 
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Step 11: Wait for the connection to be established 

 

 

 

 

 

 

 

 

 

 

Tips & Warnings 

If the connection fails shown as follow, return to step 10 to do the action below 

 

 

 

 

 

Open the command prompt, run the 

“ConmanClient2.exe/transport:tcpconnectiona.dll/property:port=5000/id:Con” at: 

\System_Disk\ICPDAS\System, and then run the “CMAccept.exe” 
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C. How to Automatically Synchronize XP-8000-CE6 Clock with an 
Internet Time Server 

The clock on the XP-8000-CE6 can be synchronized with an internet time server. This means that 

the clock is updated to match the clock on the time server, which can help ensure that the time on 

the XP-8000-CE6 is accurate. Here are step by step instructions on how to synchronize the clock on 

the XP-8000-CE6 with an Internet time server.  

 

 

Step 1: Run the XPAC Utility 

 

 

 

 

Step 2: On the General tab, press Configure button 
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Step 3: Select the domain name from the Server drop-down list, and then enter a value 
in the Autoupdate Frequency field 

Step 4: Check the Automatically synchronize with an internet time server check box 

 

 

 

 

 

 

 

 

 

 

 

 

Step 5: On the File menu, click Reboot 

 

 

 

 

 

 

Step 6: The XP-8000-CE6 will automatically synchronize with an internet time server 
regularly 

 

 

Step 7: Click the Update Now button to 
synchronize XP-8000-CE6 clock 
immediately 

 

 

 

 



XP-8000-CE6 User Manual (for WinCE 6.0 Based XPAC), version 1.0.5         Page: 178 

Copyright ©  2018 ICP DAS Co., Ltd. All Rights Reserved.   E-mail: service@icpdas.com 

 

D. How to Control the User Account Control in XP-8000-CE6 

User Account Control is a security feature that helps prevent unauthorized system changes to the 

XP-8000-CE6. 
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D.1. How to Create a User Account 

Here are step by step instructions on how to add a user account. 

 

 

Step 1: Run the XPAC Utility 

 

 

 

 

 

Step 2: On the Login tab of the Network tab, click Login tab, type the User Name and 
Password, and then click Add button 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



XP-8000-CE6 User Manual (for WinCE 6.0 Based XPAC), version 1.0.5         Page: 180 

Copyright ©  2018 ICP DAS Co., Ltd. All Rights Reserved.   E-mail: service@icpdas.com 

 

Step 3: The user has been added to the allowed under the remote login and included in 
the following list 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 4: On the File menu, click Reboot for changes to take effect 
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D.2. How to Telnet to Remote Login the XP-8000-CE6 from PC 

Here are step by step instructions on how to use telnet to remote login the XP-8000-CE6 from PC. 

 

 

Step 1: On the PC, open a MS-DOS command prompt 

 

 

 

 

 

 

 

 

 

 

 

 

Step 2: At the command prompt, type “telnet (IP address)” 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 

2. Type “cmd” 
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Step 3: The connection has been set up, and then type the name and password 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 4: The remote login has been completed 
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D.3. How to Remove a User Account from the Login List 

Here are step by step instructions on how to remote the user from the login list. 

 

 

Step 1: Run the XPAC Utility 

 

 

 

 

 

Step 2: On the Login tab of the Network tab, click Login tab, click a user from the list 
which you want to remove, and the user will display in the field, and then press 
Delete to delete the user from the login list 
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Step 3: On the File menu, click Reboot for changes to take effect 
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E. How to use PACSDK library to program the XP-8000-CE6 

 

E.1. How to Read the XPAC Mode with PACSDK library 

 

The rotary switch is used to set the operating mode.  

 

 

 

 

 

 

 

 

 

During normal operation, the position of the rotary switch has no effects on XP-8000-CE6.  

You can use PACSDK API to read back the value of the rotary switch. 

 

int pac_GetRotaryID(); 

 

The returning value of pac_GetRotaryID() is what the arrow points to. 
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E.2. How to Read the Module ID with XPAC API 

The DIP switch can be used to set the Module ID to a number from 0 to 255. Do not use Module ID 

0 for communication. 

 

During normal operation, the positions of the DIP switches have no effects on XP-8000-CE6. 

You can use PACSDK API to read back the value of the DIP switches. 

 

int pac_GetDIPSwitch(); 

 

Below is the figure of DIP switches similar to that of XP-8000-CE6. 

The first DIP switch is the LSB and the 8th DIP switch is the MSB. 

If the DIP switch slides up to the “ON” side, it represents 1. 

If the DIP switch slides down to the number side, it represents 0. 

In this way, the eight-bit DIP switches can be represented by 0 ~ 255. 
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E.3. How to Use the Multi-IO Module with XPAC API 

The Multi-IO Modules tab provides function to check the driver of multi-IO modules, such as 8114, 

8144, 8142, and 8112.  

For more information about expansion RS-232/RS-422/RS-485 communication module that are 

compatible with the XP-8000-CE6, please refer to 

http://www.icpdas.com/products/Remote_IO/i-8ke/selection_rs232_i8k.htm 

 

1. Insert the multi-IO module into XP-8000-CE6 

 

2. Run the XPAC Utility 

 

3. On the Multi-IO Modules tab, check the driver of 

the I/O modules 
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4. Program the multi-IO module 

 

Opening 8144 in Slot 1  

 

Code Snippets 

{ 

BOOL ret; 

HANDLE hOpen; 

char buf[4096]; 

 

hOpen = uart_Open("MSA1"); 

ret = uart_SendCmd(hOpen,"$01M", buf);  

uart_Close(hPort); 

} 

 

 

For more information about expansion RS-232/RS-422/RS-485 communication module that are 

compatible with the XP-8000-CE6, please refer to 

http://www.icpdas.com/products/Remote_IO/i-8ke/selection_rs232_i8k.htm 

 

 

http://www.icpdas.com/products/Remote_IO/i-8ke/selection_rs232_i8k.htm
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F. How to update software from XP-8x4x-CE6 or XP-8000-Atom-CE6 to 
XP-8x3x-CE6 

The CPU type of XP-8x4x-CE6 and XP-8000-Atom-CE6 is x86-based and the OS is also Windows 

CE6.0, so all software are compatible. All old programs and applications on XP-8x4x-CE6 and 

XP-8000-Atom-CE6 can run smoothly on XP-8x3x-CE6 without any modification and re-compiling. 

Upgrading applications only just copy and play from XP-8x4x-CE6 or XP-8000-Atom-CE6 to 

XP-8x3x-CE6. 

 

The software compatibility is listed as following: 

Software compatibility with XP-8x3x-CE6 

Compatibility Comparison     Ο: Compatible, X: Incompatible 

Items Compatibility 

OS image  X 

Rescue Disk X 

VC/C#/VB.net programs Ο 

XPacSDK_CE6 SDK (DLL file) X  

PACSDK (DLL file) Ο (Since V4.4.0.1 and later) 

All DCON 8K series library Ο 

XPAC utility Ο (Since V1.2.7.3 and later) 

NAPOPC_CE6 Ο 

Tools on System_Disk Ο 

 

Compatibility Comparison     Ο: Work, X: Doesn’t Work 

API Functions XP-8x4x-CE6 XP-8000-Atom-CE6 XP-8x3x-CE6 

pac_EnableLEDs X Ο Ο 

The others Ο Ο Ο 

Note: The version of PACSDK must be V4.4.0.1 or later 
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G. How to Change the Battery 

Step 1: Pull the locking tabs up on both sides to remove the CPU unit from the main unit 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 2: Remove the CPU board from the CPU unit 

Step 3: Use the screwdriver to pry out the old battery, and then 
insert a new battery 

 

 

 

 

 

 

 

 

 

 

Step 4: Mount the CPU board and CPU unit back in place 
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H. I-8K and I-87K Modules 

I-8K and I-87K modules provide the option to expand the local I/O to 1, 3, or 7 slots and the bus 

type for the modules can be either parallel (high profile I-8K series) or serial (high profile I-87K 

series).  

 

The differences between the two module types is as follows. 

 

Item I-8K Series I-87K Series 

Microprocessor No Yes (8051) 

Communication Interface Parallel Bus Serial Bus 

Communication Speed Fast Slow 

Latched DI Function No Yes 

Counter Input (for digital input modules) No Yes (100 Hz) 

Power-on Value No Yes 

Safe Value No Yes 

Programmable Slew-Rate for AO modules No Yes 
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I. Revision History 

This chapter provides revision history information to this document. 

 

The table below shows the revision history. 

 

Revision Date Description 

1.0.0 October 2016 Initial issue 

1.0.1 March 2017 Modified the power specification in section 1.2. Specification 

1.0.2 March 2018 
Added the information about XP-8031-CE6 in Chapter 1. 

Introduction 

1.0.3 September 2021 

1. Modified the information about Recovering the 

XP-8000-CE6 in section 7.1 Recovering the XP-8000-CE6 

2. Added the information about how to change the battery in 

Appendix G. How to Change the Battery 

1.0.4 September 2021 
Modified the information about Recovering the XP-8000-CE6 in 

section 7.1 Recovering the XP-8000-CE6 

1.0.5 December 2023 
Added the tips and warnings information about the CF card 

supported in section 1.3. Overview 
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